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Chapter 1: Package Installation

1.1 Overview

This document describes how to install the AX-8xxXEPO Series_1.0.0.0 package in the
CODESYS V3.5 SP14 softwar. After the installation, the device releated confinguration
will build-in CODESYS software and user can use the IEC program, configuration, and
funcitons to implement the project.

1.2 Software and Package Download
Please download the Codesys software as below link.

® Codesys standard software
http://www.deltaww.com/services/DownloadCenter2.aspx?seclD=8&pid=2&tid=0&C
ID=06&itemID=060210&typelD=1&downloadID=&title=&dataType=8;3:&check=1&h
I=en-US

® Package: AX-8xxEPO Series_1.0.0.0
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1.3 Package Installation
Please install the Codesys sodtware first and follow the below step to install package.

1. Download the Package in Delta download center
P AX-8xxEPD Series_1.0.0.0.package

2. Open th Codesys Development Software



http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060210&typeID=1&downloadID=&title=&dataType=8;3;&check=1&hl=en-US
http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060210&typeID=1&downloadID=&title=&dataType=8;3;&check=1&hl=en-US
http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060210&typeID=1&downloadID=&title=&dataType=8;3;&check=1&hl=en-US

3. Click “Tools” — “Package Manager”
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Select the Package - AX-8xxEPO Series_1.0.0.0
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1.4 Open AX-8 Series Configuration
After the package installation, user can follow the below steps to create the AX8 series
project and config the releated program, function, and configuration.

1. New project

w CODESYS

File Edit %ies Project Build Ordline Debug  Tool Window Help

R A~ =g « F PR X | # e L B B IR a Pom
Dieicis - 0 :tl ' Skark Fage

-

G Dpan Profert—
@ opan Praject From PLC...

Racent Projects

2. Choose Standrad Project > Device: AX-8xxXEPO Series, and choose the PLC_PRG.
Standard Project X

You are about to create a new standard project. This wizard will create the following
objects within this project:

- One programmable device as specified below

- A program PLC_PRG in the language specified below

- A cyclic task which calls PLC_PRG

- & reference to the newest version of the Standard library currently installed.

Device: CODESYS Softmotion RTE V3 x64 (35 - Smart Software Solutions GmbH)

. |AME10-CPU1608TP iShenzhen Inovance Control Ted'lnoloiii |
GOSMLCRURY )\ _5,xEPD Series (Delta Electronics, Inc.
CODESYS Control RTE W3 (35 - Smart Software Solutions GmbH)
CODESYS Control RTE V3 x64 (35 - Smart Software Seolutions GmbH)
CODESYS Control WECTARM Dualcore (35 - Smart Software Solutions GmbH)
CODESYS Control Win V3 (35 - Smart Software Solutions GmbH)
CODESYS Control Win W3 x64 (35 - Smart Software Solutions GmbH)
CODESYS HMI (35 - Smart Software Solutions GmbH)
CCODESYS SoftMotion RTE V3 (35 - Smart Software Solutions GmbH)

CODESYS Softmotion RTE V3 x84 (35 - Smart Software Solutions GmbH)
CODESYS SoftMotion Win Y3 (35 - Smart Software Solutions GmbH)
CODESYS SoftMotion Win V3 x84 (35 - Smart Software Solutions GmbH)




3. The project will create ad below picture.
» Untitled1.project* - CODESYS

File Edit \iew Project Build Online Debug Tools Window Help

&= YR R b O | i
Devices + 1 X (1] pevice x
=5 Untitieds ~
=[] Device (AX-8xxEPD Series) Communication Settings
= @1] Plc Logic

=1L} Application Applications

m] Library Manager
PLC_PRG (PRG)
= @ Task Configuration

Backup and Restore

Files
% EtherCAT Task
= @ MainTask Log
& PLC_PRG
m EtherCAT_Master (AX-8xxEPD Series EtherCAT Mas PLC settings
=& Builtin
[ Buitin_DIO (Builtin_DIO) PLC shell

ﬁ Builtln_Pulse_Encoder (Builtin_Pulse_Encoder)

2 softMaotion General Axis Poal Users and Groups




1.5 AX-8 Series Parameter

AX-8 Controller parameter setting in Codesys software.

1. Open project
[ Lol |
= | e (uxAutPS Seriex)

= B Pickoge
« ) Apsbeation
.| L sy Marage
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= E Sk Cowi lera ban
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= i Mg
=] mC e
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T Bl P00 (Beiln 00

= AX-BxxE Operating Parameter Setting

Builtin_DIO Setting
« DWDO Parameter Setting
«  OIDO Mapping

] Sudtin_Puse_Ericoder (Buitin Pulse Erosder]

"3 Coftobon Ganersl Lids Pool

*  Builtin_Pulse_Encoder Setting

+ Pulse_Encoder Parameter Setting
*  Pulse_Encoder Mapping

4. Application Run Mode : Set RTE and PLC “Run” status when controller active
B Setting Value : True, False

B Default Value : False

B Offline can change the setting
B After Download, the status will run.
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5. Serial Communication Mode :
Setting Value : RS-485, RS-422, SSI

Default Value : RS-485

Offline can change the setting
After Download, the status will run.

Windows device administrator default comport : COM3
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6. Builtin_DIO Parameter:
B DI Filter Select . Set X0~X7 input filter time
€ Setting Value : Not Filter ~ 0.1ms ~ 0.5ms * 1ms

Default Value : Not Filter

Offline can change the setting
After Download, the status will run.

L 2 2R 2

B DO Output Inverse : Set YO~Y7 out reserve
€ Setting Value : True - False

& Default Value : False

€ Offline can change the setting
& After Download, the status will run.
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B X0 Function Type Choose : Set X0 as general output or special software
functions
Setting Value :

A. General Input
B. Stop/Start PLC Control

€ Default Value : General Input
€ Offline can change the setting
4

*

After Download, the status will run.
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< Note: Stop/Start PLC Control Timing diagram
€ Whne X0 is Low, Application—Reset —Run
€ When X0 is High, Application Stop
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7. Builtin_DIO I/O Mapping :

B |/O Mapping : Input or output Mapping
€ Input 0 or Output 0 Mapping (Type: Byte)
€ XO0~X7 or YO~Y7 Single in/foutput Mapping( Type: BOOL)
i cevem  vumn_peo x
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8. Builtin_Pulse_Encoder Parameter:

B Pulse Encoder input type :

*

¢

\ 4
*

Setting Value : A/B Phase - CW/CCW

Default Value : A/B Phase

Offline can change the setting
After Download, the status will run.

Pulse Encoder input direction

¢

*

*
¢

Setting Value : True(Inverse) - False(Normal)

Default Value : False

Offline can change the setting
After Download, the status will run.

Pulse Encoder Z Inverse :

*

L 2 2R 4

Setting Value : True(Inverse) * False(Normal)

Default Value : False

Offline can change the setting
After Download, the status will run.
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9. Builtin_Pulse_Encoder 1/0O Mapping:
B Pulse_Encoder Mapping : Pulse Encoder Input and Reset Mapping

€ Counte r(Type : DINT)
¢ Reset (Type: BOOL & Execution)

Buliln_Pulze Encocder Parameters  Fird Fiket Showall » mpr el FB for H char
arialle M Channal  Address T Umir | Desorigban
Buthin_Fulse_Encoder 10 Sappleg SEng e b
10 RIDL LN Cotnler valie
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Pulse_Encoder example :

® Add Device-> Add “SMC_FreeEncode” and map with Counter &
= '3 _SoftMotion General Axis Pool

@ SMC_FreeEncoder (SMC_FreeEncoder)

&) AX3 (SM_Drive_Virtual) \

Builtin_Pulse_Encoder

I BuiltIn_Pulse_Encoder Parameters | Find Filter Show all

I Builtin_Pulse_Encoder 1/0 Mapping Vadsble ¥ Mapping  Channel Address
i | % sopicaton.suc_Freeencoder dencoderposton | B Conter 308
Builtln_Pulse_Encoder IEC Objects || | f Reset  %QX29.0

® Use Encoder of R1-EC5621 as output to AX-8xxE Pulse Encoder

® Use SMC_FreeEncoder as master axis and do Grarln with virtual axis.




Chapter 2: CODESYS variables share to DIAScreen

2.1 Overview

DIAScreen have support to import variables of Codesys software. User can define the
variables in Codesys development software and export the xml file of symbol
configuration. Import the xml to DIAScreen to communicate between controller and
Delta HMI functions.

Please download DAIScreen Installation in Website

http://www.deltaww.com/services/DownloadCenter2.aspx?seclD=8&pid=2&tid=0&CID=
06&itemID=060210&typelD=1&downloadID=&title=&dataType=&check=0&hl=zh-TW

Support PAC AX-8 series and DOP-100 series.

2.2 Export Variable in Codesys
Build the Global Variable list and export the symbol configuration.

1. Right click “Application” - “Add Object” - “Global Variable List”
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http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060210&typeID=1&downloadID=&title=&dataType=&check=0&hl=zh-TW
http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060210&typeID=1&downloadID=&title=&dataType=&check=0&hl=zh-TW

2.

Import the Global Variable list naming.

Add Global Variable List

“ Create a new global variable list

Add | | Cancel
Build Variable in GVL
‘__-_.__. - ¥ x { ‘G‘l x. Library Macager
= 3 unevess et 8 X
= 5 Device BT Sevies)
o B~ Logc Scope Have Acddeecs  Dats type Initiabay
= © Aspication W R G00K  Axis_I_MC_Malt_Abborted 00
oo 1 W R mona | Axi 8 HC Malt Busy ook
5 oo Marager 1 @ e aoes  Ax I MC_Makt_Decelerstion meA
] ACPRG (PRE) W U8 ROOA  Axis_1_NC_Malt_Dsoe poo,
~ @ Tk Conbiganton W R Gons  Axis I MC_Malt_trer oo
& StrcaT Tk W onoomR Axis_I_NC_Malt_frroetD S _ssmon
* & ek W GoBs Aws 8 MC_Halt_Excute 00U
&) pcres dW o mona Axe_1_MC_Malt_Jerk REA
3] SewrCAT Muster (AX 208 Zeries| Ol e Goea Awis_t_MC_Power Susy soct
= % sattn W R G0BA Ais_t_MC_Power_DriveStart 00
§ suten 210 duis 1) W 4n GooA  Axia_I_NC_Power_DriveStartheatState 2oCL
T bt e Ercader Bttt By W GoBa Ads_t_MC_Puwer_Enable 000
B Safoson Geners Axis Pocs SN R GoBA  Ais_t_MC_Power_Ervor 200L
T 8 R GOOA  Axis_I_MC_Power_TrroriD SMC_IFROR
W 008 Ads_1_MC_Power_Regulatoron 0L
4O R GOBR  Axs 1 _NC_Power_RequistorRealState BOOL
U R ROBA Axis_I_NC_Puwer_Status oot




4. Application - Add Object - Symbol Configuration
@ Lintitled t projece* - CODESYS
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5. Choose “ Include Comments in XML”

Add Symbeol Configuration *
B8 (Createaremoteaccess symbol configuration.
Name:
|Symbnl Configuration
[+] Include Comments in XML
Support OPC UA Features
Add library placeholderin Device Application
recommended, but may trigger download)
Client side data layout
() Compatibility Layout
(@) Optimized Layout
Add I | Cancel
6. Click “Build” - Choose “ GVL”
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7. Go to toolbar = “Build” = “Generate code”

Fle Edit Wiew Project | Build | Online Debug Tools ‘Window Help

Build F11 - [
Rebuild
Generate code ‘m
=) Listitied 1 Generate runtime system files... —
= [l Device (AX-BxxEPD Series Clean fttings
-@ﬂ Plc Logic Clean all
e | I

8. The xml will in the assign folder.
» T > TWEW (D) > DELTA » WE > BESE > FB » MC_Halt » 8

¢ A 2® | BT EN
o R MC_HaltDevice Application.5s474da8-fae1-4b.  2019/3/28 1
o | MC_HaltDevice Application.53474da8-fae1-4b..  2019/3/28 !
‘ | MC_HaltDevice Application.5a474da8-fae1-4b.  2019/3/28
1 £ MC_HaltDevice Application.xml 2019/3/29 7
® MC_Haltproject 201973728 ¢

2.3 DIAScreen with PAC AX-8 Series
1. Open DAIScreenV1.0 - “New File” > Choose “AX8xxE” model.
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2. Go to “Codesys” in Project Tree
Project X

T -
Eﬂ MewHMI
- Screen
Eg..-jj Communication
@ Tag
5] Alarm
E}E Recipe
-.|[E8] Histary Buffer
----- @ Multi-language
..... ﬂ. Account Settings
..... A Configuration
..... ] Text Bank
5% Picture Bank




3. Click the “Import” and choose the xml file which export from Codesys.
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4. The symbols show in DIAScreen.
tRle Ecbt Wimw Elerer® Cermap Tonls  Chthoes b

12 -

- Siate ssfaction

£1-E0 PlarwHKA .
'r'l-‘l:.'j Ecraan ":f"-'b'u' Ty
{1} Communicatian = Apobcaton
qu 5. vt
[i] Almrm i B ULMT
i+ Recipe |- Suii_MC HetMbored  BOOL
Hisony BuFer b AT _MC_Halt Busy BCOL
@ MAuti-language - AsI_MIC Hait Decelem_ . LREAL
A Account Setting | AT_MC_Hait Dore BOOL
a4 Confgumbon = P T_WIC_Halt Ennai BOOIL
T Teet Bk [ A1 WaC Halt EmoilD ShAC_ERFOR
&% Prture fark | Eul_hAC_Halt Eusailie BCOL
# Codess | At e Halt lark LREAL
& DA Tag I B 1_KAC _Pormar_Eiiey BOOL
-+[#] Piogram {- fwdl_WC_Power DriveSt  BOOL
] Edmin [ Bait_MC_PomarDriveSi BDOL
| B WC Poemr Erable  BOOL
I Bl _KWiC_Pomer_Encr ECHOL
I Aol MC Poemr Encell  SKAC_ERFOR
' B8 _WAC_Powar Ragd . BOOL
! B O M e T ]




5. Insert the Element and Double click the element. User can choose the Codesys
parameter to connect with the element.
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2.4 DIAScreen with PAC AX-8 Series
1. Open DAIScreenV1.0 2> “New File” > Choose “DOP-100" series > Next
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Project Wizard - Ethernet 1> New Network Links - Choose “CODESYS”
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3. Import - Add Tag List = Import Codesys xml
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4. Insert the Element and Double click the element. User can choose the Codesys

parameter to connect with the element.
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